RocketPort® Serial Hub Series
Software Installation and
Configuration Guide

RocketPort® Serial Hub Series
Software Installation and
Configuration Guide

Copyright © 1998. Comtrol Corporation.
All Rights Reserved.
First Edition, December 4, 1998
Comtrol Corporation makes no representations or warranties with
regard to the contents of this guide or to the suitability of the Comtrol
products for any particular purpose. Specifications subject to change
without notice. Some software or features may not be available at the
time of publication. Contact your reseller for current product
information.
Trademarks
Comtrol is a trademark of Comtrol Corporation.
RocketPort is a registered trademark of Comtrol Corporation and
VS-Link is a trademark of Comtrol Corporation.
Microsoft and Windows NT are registered trademarks of Microsoft
Corporation.
Citrix and WinFrame are registered trademarks of Citrix Systems, Inc.
Other product names mentioned herein may be trademarks and/or
registered trademarks of their respective companies.
Corporate Headquarters:
Internet URL: www.comtrol.com
email: support@comtrol.com
FTP site: ftp.comtrol.com
FAX: (651) 631-8117
Phone: (651) 631-7654
Comtrol Europe:
Internet URI: www.comtrol.co.uk
email: support@comtrol.co.uk
FAX: +44 (0) 1 869-323-211
Phone: +44 (0) 1 869-323-220

Document Part Number: 2000000 Revision A

Table of Contents

List of Tables
Introduction
Scope ...................................................................................................... 9
Operating System Requirements .................................................... 9
Connectivity Requirements.............................................................. 9
Installation Overview....................................................................... 10
Initial Installation - Quick Reference ........................................... 10
Installing VS-Link Updates - Quick Reference ............................ 10
Adding a Unit to an Existing Installation - Quick Reference ...... 11
“Hot-Swapping” Hardware - Quick Reference .............................. 11
Obtaining Software or Document Updates ................................. 12
Comtrol Corporate Headquarters.................................................. 12
Comtrol Europe .............................................................................. 12
Technical Support ............................................................................. 13

Windows NT
VS-Link Installation and Configuration Overview................... 15
Removing Existing VS-Link Software.......................................... 17
VS-Link Software Installation ....................................................... 19
Extracting the Files........................................................................ 19
Installing a New Version of VS-Link............................................. 20
Verifying the Installation............................................................... 29
Using VS-Link .................................................................................... 30
Accessing VS-Link Menus ............................................................. 31
Changing Configuration Parameters ............................................ 33
Configuring the Backup Server Feature ....................................... 34
Adding Units After the Initial Installation................................... 35
“Hot-Swapping” Units .................................................................... 36
Using Optional VS-Link Features ................................................. 37

5

Table of Contents

Configuring Specific Port Features ............................................... 40
Configuring Modems ........................................................................ 45
Working with NT RAS ................................................................... 45
Modem Installation ........................................................................ 45
Further Configuration.................................................................... 49
RAS Installation and Configuration ............................................. 50
Initial RAS Installation ................................................................. 50
Adding or Reconfiguring a RAS Device......................................... 53
Printer Configuration ...................................................................... 58
Adding Serial Printers ................................................................... 58
Changing Printer Port Configuration ........................................... 61
Changing Printer Port Assignment............................................... 62
Using Test Terminal (wcom32.exe)................................................ 63
Testing a RocketPort Serial Hub ................................................... 64
Modem Control Signals.................................................................. 65
Using Port Monitor (portmon.exe) ................................................ 65
Starting Port Monitor..................................................................... 66
Changing Screen Appearance........................................................ 67
Column Setup ................................................................................. 68
Report Configuration ..................................................................... 69
Port Monitor Files .......................................................................... 70
Port Monitor Variables ................................................................... 71
Using Peer Tracer (peer.exe) .......................................................... 74
Starting Peer................................................................................... 74
Log Functions ................................................................................. 74
Using Peer....................................................................................... 75
Other Commands ........................................................................... 75
Using the Device Advisor ................................................................ 76
VS-Link Messages.............................................................................. 79

Index

6

List of Tables

Table 1.
Table 2.
Table 3.
Table 4.
Table 5.
Table 6.

Support Call Information..................................................... 13
Port Monitor Screen Commands ....................................... 67
Port Monitor Variable List ................................................. 71
Peer Tracer Commands........................................................ 75
VS-Link Summary Messages ............................................. 79
VS-Link Reported State Messages .................................... 81

7

List of Tables

8

Introduction

Scope
This Guide discusses software installation (VS-Link). VS-Link for
Windows supports several products, including:
•

VS1000 and VS1100 High-Density Serial Hub

•
•

VS2000 Analog Modem Hub
RocketPort Serial Hub

Note: VS-Link is the device driver and supporting applications
provided with the product.
For hardware specific information, see the Hardware Installation Card
that came with the product or download it from the ftp/web site.

Operating System Requirements
The RocketPort Serial Hub requires at least one network server
running one of the following operating systems:
•

Microsoft Windows® NT (3.51, 4.0, or higher)
Note: Windows NT 4.0 or higher is required to support Multilink
PPP.
RAS or RRAS is required to support Remote Access Service.

• Citrix® WinFrame® (1.7 or later)
Microsoft supports up to 256 RAS ports.

Connectivity Requirements
An Ethernet connection, either to an Ethernet hub or to a NIC card in
the host server. (See the Hardware Installation Card for information
regarding hardware installation.)
Note: If connecting the RocketPort Serial Hub directly to the server,
an Ethernet crossover cable is required.

Scope
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Installation Overview
The following subsections outline the various RocketPort Serial Hub
installation scenarios. For more information about hardware issues,
see the Hardware Installation Card. For more information about
software issues, see Installing a New Version of VS-Link on page 20.
Initial Installation - Quick Reference
Use the Hardware Installation Card to install the hardware for the
first time or this procedure:
1. Install the RocketPort Serial Hub.
2. Install RS-232 serial devices.
3. Connect the RocketPort Serial Hub to the network hub or server.
4. Power-up the new RocketPort Serial Hub and verify that it passes
the power-on diagnostics.
5. If necessary, unzip the VS-Link distribution file, see Extracting the
Files on page 19.
6. Install and Configure VS-Link, see Installing a New Version of VSLink on page 20.
7. Configure serial ports to support the RS-232 devices.
8. Shut down and restart the server.
Installing VS-Link Updates - Quick Reference
This procedure lists how to update VS-Link:
1. Remove the existing VS-Link, see Removing Existing VS-Link
Software on page 17.
2. Install and configure the new version of VS-Link, see Installing a
New Version of VS-Link on page 20.
3. No port configuration changes are required.
4. Shut down and restart the server.
Note: There are no hardware changes required when updating VSLink.
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Adding a Unit to an Existing Installation - Quick Reference
Use this procedure to add another RocketPort Serial Hub to an
existing configuration. For detailed installation information, see the
Hardware Installation Card,
1. Install the RocketPort Serial Hub.
2. Install RS-232 serial devices.
3. Connect the RocketPort Serial Hub to the network hub or server.
4. Power-up the new RocketPort Serial Hub and verify that it passes
the power-on diagnostics.
5. Configure VS-Link to support the new RocketPort Serial Hub, see
Adding Units After the Initial Installation on page 35.
6. Configure serial ports to support the RS-232 devices.
7. Shut down and restart the server.
“Hot-Swapping” Hardware - Quick Reference
Follow this procedure, to “hot-swap” a RocketPort Serial Hub with
another RocketPort Serial Hub in an existing configuration. The
Hardware Installation Card details hardware installation.
1. Power-down the RocketPort Serial Hub to be removed from service.
2. Install the new RocketPort Serial Hub.
3. Transfer all cabling from the old RocketPort Serial Hub to the new
RocketPort Serial Hub.
4. Connect the new RocketPort Serial Hub to the network hub or
server.
5. Power-up the new RocketPort Serial Hub and verify that it passes
6. Change VS-Link to reflect the network address (MAC) of new
RocketPort Serial Hub unit.
7. No port reconfiguration is needed.
8. Do not shut down and restart the server.

Installation Overview
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Obtaining Software or Document Updates
For information that is not in this Guide, see the README and/or Help
files on the installation media.
Comtrol manuals and other documents are available in electronic form
on the Comtrol web site. Driver software updates can be downloaded at
no charge from the Comtrol ftp site. Always check the web and ftp sites
to make sure that you have the current driver and documentation.
Documentation can be located in the Docs directory of the ftp site or
you can use the web site search engine to locate either hardware or
software documentation.
The current released version of the software is stored in the SerialHub
directory. If a newer version has reached the beta testing stage, it can
be found in the BETA directory. Beta software is made available on an
“as-is” basis and users of beta software assume all risks and liabilities
relating thereto.
Note: Downloadable driver software files are stored in either zipped
(filename.zip) or self-extracting zip (filename.exe) format. You
must extract the zipped files before installing a downloaded file.
For more information, see the appropriate section for your server
operating system.

Comtrol Corporate Headquarters
Internet URL: www.comtrol.com
email: support@comtrol.com
FTP site: ftp.comtrol.com
FAX: (651) 631-8117
Phone: (651) 631-7654
Comtrol Europe
Internet URL: www.comtrol.co.uk
email: support@comtrol.co.uk
FAX: +44 (0) 1 869-323-211
Phone: +44 (0) 1 869-323-220
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Technical Support
Comtrol has a staff of support technicians available to help you. U.S.
telephone support is available from 8 AM to 6 PM Central time,
Monday through Friday (holidays excluded), at the phone number(s)
listed on the previous page.
You should review Troubleshooting on page 63 and run through basic
diagnostics before calling Technical Support. In addition, please have
the following information available.
Table 1. Support Call Information
Item
Hardware Type

Information
RocketPort Serial Hub

Hardware Serial Number*
Network Address*

00 C0 4E ____ ____ ____

Operating system type and
release
VS-Link version number
Server computer make,
model, and speed
Other serial port adapters
installed in the server and
their COM port numbers
Other network adapter
devices installed in the
server and their network
(MAC) addresses
*

The hardware serial number and network address can be found on
printed tags on the back panel of the unit

Comtrol supplies a self-adhesive label with each RocketPort Serial Hub
unit, which you can use to record the serial number and network
address. If the RocketPort Serial Hub unit is not in a readily accessible
location, check to see if this label has been filled out and posted
elsewhere (for example, near the server console).

Technical Support
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Windows NT

This section discusses VS-Link software for the RocketPort Serial
Hub. VS-Link for Windows supports several products, including:
• VS1000 and VS1100 High-Density Serial Hub
•

VS2000 Analog Modem Hub

•

RocketPort Serial Hub

Note: VS-Link is the device driver and supporting applications
provided with the product.
However, because of differences between the products, the VS1000 and
VS2000 are discussed separately in their own Installation and
Configuration Guides.

VS-Link Installation and Configuration Overview
This section contains information about VS-Link installation,
configuration, and use of RocketPort Serial Hub in a Windows NT
operating system. The topics include:
• Removing an existing version of VS-Link to upgrade VS-Link
•

Changing VS-Link configuration after initial installation to:
- Configure and use the Backup server feature, which allows you
to define one server as the primary server for a given
RocketPort Serial Hub and one or more other servers as backup
servers for the same RocketPort Serial Hub.
Note: if you have more than one Windows NT server on a network.
-

-

Add RocketPort Serial Hub units after initial installation.
“Hot-swap” RocketPort Serial Hub units in and out of service.
“Hot-swapping” allows you to replace an existing and
configured RocketPort Serial Hub with an identical unit,
without downing the server or reconfiguring ports.
Lock baud rates to access to higher or lower rates than are
normally permitted by your Window NT applications.
Set VS-Link for use with an RS-232 to RS-485 convertor box

-

Set the scan rate

-

VS-Link Installation and Configuration Overview
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•

Setting up the ports to use, including:
- Modems
-

•

Quick reference for installing and configuring RAS
Printers

Troubleshooting using the following utilities:
-

Test Terminal
Port Monitor

-

Peer Tracer

- Device Advisor
If you are installing VS-Link for the first time, start with VS-Link
Software Installation. If you are updating the software on an existing
VS-Link installation, start with Removing Existing VS-Link Software.
In all other cases, see the appropriate section as listed above.
For specific information about the following topics for your hardware,
see the hardware documentation that came with your product.
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Removing Existing VS-Link Software
Use the following procedure to remove any existing VS-Link software.
If updating (not reconfiguring) VS-Link, make sure that you remove
the existing version before installing updated software.
Note: Using the Remove button on the Comtrol Main Setup sheet only
discards the software configuration, it does not remove the
software.
1. Right-click on the Network Neighborhood, and select Properties or
open the Control Panel and start the Network applet.
2. If using Windows NT 4.0, select the Adapters tab. If using
Windows 3.51, skip to the next step.

3. Highlight Comtrol VS1000/VS2000/RocketPort Serial Hub.
Note: While VS-Link for Windows NT supports several products,
the VS1000 and VS2000 are covered separately in their own
Installation and Configuration Guides.
4. Click the Remove button. You are asked to verify that you want to
delete this item.

Removing Existing VS-Link Software
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5. Click Yes. The selected item is removed from the Network
Adapters window.
6. Click Close. Several windows display as the system updates.

When the updates are complete, this message displays:

7. Click Yes to shut down and restart the server, so that your changes
take effect.
After removing the existing driver, use the VS-Link Software
Installation discussion.
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VS-Link Software Installation
Use the following procedures to install VS-Link for the Windows NT
3.51 or 4.0 operating systems. If using Citrix WinFrame, follow the
instructions for NT 3.51.
Note: If updating VS-Link, remove the existing version of VS-Link
first. Do not use the Update option.
These procedures assume that you have already installed the
hardware and determined that it is working properly. For information
about the power-on diagnostic and understanding the LED status
indicators, see Hardware Installation Card.
Note: In a new installation, the lower 10BASE-T LED should be lit (if
using a 10Base-T Ethernet connection) and the Port 1 light
should be flashing (waiting for VS-Link to load).
Extracting the Files
VS-Link for Windows NT may be shipped as a self-extracting zipped
file. Not all versions of VS-Link media contain zipped files. If the VSLink file name follows this format, 6613Vx_xx.exe, it is a zipped file;
where x_xx is the software version.
Note: If the VS-Link software is not zipped, see Installing a New
Version of VS-Link on Page 20.
If VS-Link files are zipped, you must unzip the file before you can
install VS-Link. Use the following procedure:
1. In Windows Explorer, create a subdirectory. For example:
Comtrol
Note: We recommend creating a new directory to place the zipped
file into.
2. Locate the 6613x_xx.exe file on the distribution media, or
download it from the Comtrol ftp site.
3. Double-click on 6613x_xx.exe; the self-extractor utility starts.
The utility displays your system’s default target drive and
directory where the extracted files will be placed. (For example,
c:\temp.)
4. Optionally, enter the newly created target drive and/or directory.
5. Click the Unzip button.
When the process is finished, a reminder message displays, and
you may close the self-extractor utility.

VS-Link Software Installation
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Installing a New Version of VS-Link
This subsection assumes that you have installed the hardware, it is
operational, and you have the VS-Link files ready to install (see
Extracting the Files on Page 19, if necessary).
Note: The Port 1 LED should be blinking, waiting for VS-link to load.
Use the following procedure to install VS-Link files.
1. Right-click on the Network Neighborhood, and select Properties or
open the Control Panel and start the Network applet. The Network
Properties window displays:

Note: All screens shown in this section are taken from Windows NT
4.0. If you are using Windows NT 3.51 or Citrix WinFrame, note
that the screens look different but have similar functions. Adapt
the instructions as needed.
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2. If Windows NT 4.0 select the Adapters tab and click the Add
button. If Windows NT 3.51, select the Add Adapter button.

3. If Windows NT 4.0, select the Have Disk button. If Windows NT
3.51, scroll down to the bottom of the list, highlight the Other
option, and select the Continue button.

VS-Link Software Installation
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4. If installing VS-Link from a diskette, insert the diskette.
5. Enter the drive and directory path to the installation files and
click the OK button.

For example, if you used the self-extractor utility to create a
Comtrol subdirectory on the c: drive, enter:
c:\comtrol
6. Click the OK button when the selection box appears with Comtrol
VS1000/VS2000/RocketPort Serial Hub highlighted.

VS-Link copies to your system and this screen appears.
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7. Select the Next button after the files load and the Add Device
Wizard appears:

8. Select the name of the product that you are installing using the
droplist and depress the Next key:

VS-Link Software Installation
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9. Select the number of ports in the drop list for the device you are
installing and depress the Next key:

10. Enter the MAC address of the device that you are installing and
depress the Next key:

Note: Type in the MAC address that is printed on a label on the
bottom panel of the device. The format of the MAC address is:
0 c0 4E XX XX XX
Where:
XX can be a one or two-digit number and must have a space
between each set of numbers.
Note: If your site has other VS1000, VS2000, or RocketPort Serial
Hub devices on the network, their MAC addresses display in the
droplist after initial installation.
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11. For an initial installation, select NO to the “Backup Server” query
and depress the Next key:

Note: See Configuring the Backup Server Feature on Page 34 for
information about the Backup Server feature.
12. Depress the Finish key when the following screen appears:

VS-Link Software Installation
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13. Optionally, rename the device. A default name Device #1 is
assigned, where: Device is the product name.

14. Verify the MAC (Network) Address.
15. Verify the number of ports for the unit.
16. Optionally change the Starting COM Port number if COM5 (default)
is not appropriate for your environment.
Note: The Starting COM port number is mapped to the first port on
the device. All higher-numbered ports on the device are then
numbered in sequence. For example, if you set the Starting COM
Port to COM5, then port 2 is COM6, port 3 is COM7, and so on.
If you have other VS-Link devices on the network, you must set
the starting COM port for this device.
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17. Select the OK button after verifying the screen. The Comtrol
Hardware Setup sheet appears:

18. Click the Add button if you want to add another device at this time
or select OK to configure this device.
Note: You must configure at least one valid VS1000, VS2000, or
RocketPort Serial Hub device.
19. Select Yes to complete VS-Link installation.

VS-Link Software Installation
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20. Click the OK button.

21. Click the Close button in the Network window.

The Windows NT system updates the bindings.
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Another advisory message regarding downing and restarting the
server displays.
22. Select Yes to shut down and restart the server.
Note: Initial installation is not complete until you have rebooted
the server.
23. If necessary, remove the installation diskette from the drive.
24. After rebooting, you can use Verifying the Installation on Page 29
to make sure that the installation was successful.
To configure additional features of VS-Link, go to the Using Optional
VS-Link Features on Page 37 to configure additional VS-Link features
or specific COM port options.
To complete setup, you may need to set up modems, RAS, or printers.
See the appropriate subsections later in this section
Verifying the Installation
After rebooting the system, VS-Link downloads to the unit. The port
LEDs should be cycling their lights (instead of the Port 1 LED flashing
indicating that the unit is waiting for VS-Link).
Use the following procedure to verify the installation.
1. Open the Event Viewer.
2. Review the messages in the log.
If the installation was successful, there is a log entry for the device
stating that the VS-Link Software successfully initialized.
Note: This message is only meaningful if the hardware LED
diagnostics pass. See the Hardware Reference Card that
came with the unit.
If the installation fails, a Stop Event Log entry for the device states
that there was a problem and VS-Link did not load.
Read over the system log in the Event Viewer. If the event log states it
could not connect with the device, check the device as outlined in
Troubleshooting on Page 63. In addition, you can use the following
applications to help diagnose the problem:
•
•

Using Test Terminal (wcom32.exe) on Page 63
Using Port Monitor (portmon.exe) on Page 65

•

Using Peer Tracer (peer.exe) on Page 74

• Using the Device Advisor on Page 76
You can also select the Verbose EventLog option under the Options tab
in VS-Link, which may help you determine the problem. See Using
Optional VS-Link Features on Page 37 for more information.

VS-Link Software Installation
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Using VS-Link
Use the following subsections if you need to:
•

•
•
•
•

Change any configuration parameters, see Changing
Configuration Parameters on Page 33:
-

Name of the unit
Number of ports

-

Starting COM port number

- Backup server usage
Configure the Backup server feature, see Configuring the Backup
Server Feature on Page 34
Add additional hardware units, see Adding Units After the Initial
Installation on Page 35
Use the hot swap feature, see “Hot-Swapping” Units on Page 36
Use optional VS-Link features, see Using Optional VS-Link
Features on Page 37:
-

Enabling Verbose mode for Event logging

-

•
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Setting scan rates
Toggling RS-232 port usage to RS-485 using an external
convertor box
Configure port specific features, see Configuring Specific Port
Features on Page 40:
- Lock baud rates to access higher or lower rates than are
normally permitted by your Windows NT applications
- Set a timeout time on transmit data on a port
-

Map CD to DSR
Map 2 stop bits to 1

-

Wait for physical transmission before write

-

Close port settings
Reset port settings to the default condition

Using VS-Link
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Accessing VS-Link Menus
Use this procedure to access the VS-Link menus.
1. Start the VS-Link menus using one of the following methods:
•

Use the Start button, as displayed below:

•

Right-click on the Network Neighborhood, select Properties, and
select the Adapters tab or open the Control Panel and start the
Network applet.

Using VS-Link
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2. Go to the specific procedure that you want to perform, using the
subsections:
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•
•

Changing Configuration Parameters on Page 33
Configuring the Backup Server Feature on Page 34

•

Adding Units After the Initial Installation on Page 35

•
•

“Hot-Swapping” Units on Page 36
Using Optional VS-Link Features on Page 37

•

Configuring Specific Port Features on Page 40

Using VS-Link
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Changing Configuration Parameters
Use the following procedure to change the:
•

Name of the unit

•
•

Number of ports
Starting COM port number

• Backup server usage
Use the following procedure to change configuration parameters:
1. Start up VS-Link (see Step 1 of the Accessing VS-Link Menus
subsection, if you need help).
2. Highlight the device name that you want to reconfigure.
3. Click the Properties button.
4. Make the required changes.
5. Click the OK button after changing the necessary items.
6. Click OK to save the configuration.

Using VS-Link
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7. Select Yes to complete VS-Link installation.

8. Click the OK button to the following query:

9. Shut down the system and restart the computer.
Configuring the Backup Server Feature
If you have more than one Windows NT server on a network, you can
use the “Backup Server” checkbox to define one server as the primary
server for a given RocketPort Serial Hub unit and one or more other
servers as backup servers for the same RocketPort Serial Hub unit.
Once configured, primary-to-backup server switching is automatic. In
the event that the primary server loses control of the unit (for example,
because the primary server is down), the backup server begins counting
down the time entered in the “Time Out” field. If, at the end of this time
the primary server is still down, the backup server assumes control of
the device, in the process resetting it and reloading it with the
configuration information set up on the backup server.
To return control to the primary NT server, terminate all
communications in progress and then cycle the power on the unit.
When the unit comes back up, it will reestablish contact with its
primary NT server.
Use the following procedure to configure a backup server:
1. At a backup server (not the primary), install VS-Link using the
procedure Installing a New Version of VS-Link on Page 20.
2. At Step 11, click on the Backup Server checkbox.
3. Using the Timeout droplist, select how long the backup server
should wait before taking control and then click the OK button.
Note: This field is accessible only if “Backup Server” is checked,
designating this NT server as the backup server for the
selected RocketPort Serial Hub unit.
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4. Click OK to save the configuration.

5. Click OK to close the message about restarting your system.
6. Shut down the system and restart the computer.
If in the event your primary server goes down, this unit will attach
itself to the server you assigned.
Adding Units After the Initial Installation
Use the following procedure to add more RocketPort Serial Hub units
to an existing installation:
1. Connect the new RocketPort Serial Hub unit to the network and
power it up.
2. Start up VS-Link (see Step 1 of the Accessing VS-Link Menus on
Page 31, if you need help).
3. Click the Add button. The Add Device Wizard appears.
4. For help with the remainder of the setup, use Installing a New
Version of VS-Link on Page 20 and start with Step 7.
5. Reboot the system so that the new unit initializes.

Using VS-Link
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“Hot-Swapping” Units
On occasion, it may be necessary to replace an existing and configured
RocketPort Serial Hub unit with an identical unit, without downing
the server or reconfiguring ports. To do so, follow these steps:
1. Shut off the old RocketPort Serial Hub unit, connect all cables to
the corresponding ports on the new RocketPort Serial Hub unit,
and power up the new RocketPort Serial Hub unit.
2. Write down the network (MAC) address of the new RocketPort
Serial Hub unit on the customer service label provided.
3. Start up VS-Link (see Step 1 of the Accessing VS-Link Menus
subsection, if you need help).
4. Highlight the name of the RocketPort Serial Hub unit that you
want to swap out and click the Properties button.
5. Enter the new network (MAC) address of the new unit.
Note: Leave all other properties the same.
6. Click OK to exit the Device Properties window.
7. Click OK to exit the VS-Link Main Setup screen.
8. Click OK to save the new configuration.
9. Click OK to close the Windows restart advisory message.
The new RocketPort Serial Hub unit immediately replaces the old one
under the old unit’s device name. Restarting the system is not needed.
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Using Optional VS-Link Features
VS-Link includes several optional features that you may want to
configure for your environment, such as:
• Enabling Verbose mode for Windows NT event logging
•

Setting scan rates

•

Toggling RS-232 port usage to RS-485 using an external convertor
box

Use the following procedure to access and configure this features:
1. Start up VS-Link (see Step 1 of the Accessing VS-Link Menus
subsection, if you need help).

Using VS-Link
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2. Click the Options tab (under the Main Setup tab).

3. Optionally, click the checkbox to enable Verbose mode for the
Windows NT Event Log.
4. Optionally, select a different value for the scan rate.
Note: Typically you should leave the scan rate set to the default
value (10 ms) for most applications. To adjust latency for
timing-critical applications, select a longer or shorter
interval from the droplist, or type the rate of choice in this
field. Changes to Scan Rate do not take effect until you
restart the NT server.
5. Optionally, click the checkbox to enable RS-485.
Note: You may need to complete setting up some RS-485 features.
Go to the Configuring Specific Port Features on Page 40 for
additional RS-485 configuration.
6. Click the OK button.
7. Click the OK button on the Main Setup screen.
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8. Select Yes to complete VS-Link installation.

9. Click the OK button to the following query:

Using VS-Link
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Configuring Specific Port Features
Use this subsection to configure the following optional port features:
•

Lock baud rates

•
•

Set a timeout time on transmit data on a port
Map CD to DSR

•

Map 2 stop bits to 1

•
•

Wait for physical transmission before write
Clone port settings

•
•

RS-485 - override and lock RS-485 toggle mode
RS-485 - toggle RTS low

Use the following procedure to access and configure individual COM
port features:
1. Start up VS-Link (see Step 1 of the Accessing VS-Link Menus
subsection, if you need help).
2. Highlight the COM port that you want to configure.
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3. Click on the Properties button.

4. To configure RS-485 port options, go to Step 7.
5. On the Port Setup sheet, make any necessary changes to better fit
your environment:
• Lock the scan rate to access higher or lower rates than are
normally permitted by your Windows NT applications.
Note: Not all rates are supported by all Comtrol products. See
your Hardware Reference Card to determine if your device
supports the desired rate.
•

Set a timeout time on transmit data on a port

Note: You can select the length of time to wait for data to clear the
transmit buffer, after a host application has closed the port.
This is typically used with slower peripheral devices such
as printers, to give the data sufficient time to flush through
the system.
•

Map CD to DSR

Note: You can use this option in installations where there is no
connection to the port’s DSR input. It causes the CD input
to appear as DSR to the host application, and to perform
hardware handshaking with CD rather than DSR. This
option is ignored if DSR flow control is not enabled through
IOCTL_SERIAL_SET_HANDFLOW. If the application you
are using is hardcoded to use two stop bits and you are
receiving framing errors, you can implement this option.
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•

Map 2 stop bits to 1

Note: You can use this option to map 2 stop bits to 1 bit. Leave
this box unchecked to enable stop bits to pass through
unchanged.
•

Wait for physical transmission before write

Note: Use this option to force all write packets to wait until the
transmit data has physically completed the transmission
before returning completion to the host application. The
default mode (box not checked) is to buffer the data in the
transmit hardware buffer and return completion as soon as
the packet is in the buffer.
•

Clone port settings

Note: If this box is not checked, the changes you make to the Port
Setup options apply to the selected port only. If this box is
checked, the changes you make to the Port Setup options are
applied to all Comtrol VS-series and RocketPort Serial Hub
ports in the system.
6. Click the OK button.
7. Optionally, complete RS-485 configuration, highlight the COM
port that you want to toggle RS-485.
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a. Click on the Properties button.
b. Click the RS-485 tab.

c.

Check the first box to override and lock to RS-485 for the
selected port.
d. Check this box to toggle the RTS output signal low during data
transmission. If this box is not checked, RTS is toggled high
(asserted) during data transmission.
Note: To use RS-485, you must have an external RS-485 adapter.
For information about external adapters, see the
documentation that came with the external adapter.
If you do not have an external RS-485 adapter, do not use
this option.
e.

Click on the Ok button.
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8.

Click the OK button.

9. Select Yes to complete VS-Link installation.

10. Click the OK button to the following query:
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Configuring Modems
After installing the hardware and VS-Link for Windows NT, use this
discussion to configure modem COM ports.
The RocketPort Serial Hub can support any asynchronous serial
modem for use by any application that uses TAPI. For information
regarding port pinouts and signals, see the Hardware Installation
Card.
Working with NT RAS
Comtrol products are frequently used to provide Dial-Up Networking
access with NT RAS (Remote Access Service).
•

If RAS is not installed, note that you must install at least one RAScapable device (i.e., modem) before installing and configuring RAS.

•

If RAS is installed, note that the modem installation process
automatically launches RAS Setup after modem installation is
complete.

Modem Installation
The following instructions were developed using Comtrol modem
products. If you are using another brand of modem, note that some
prompts and screen descriptions may differ from those shown.
Follow these steps:
1. If using an external modem, connect the modem to the desired port.
Power up the modem.
2. Open the Control Panel window.
3. Double-click the Modems icon.
If you have no other modems installed, skip to Step 5.
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If you have already installed another modem, the Modems
Properties window displays:

4. Click the Add button.
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The Install New Modem window displays:

5. Check the “Don’t detect my modem...” box and click Next.
Note: While Windows NT can automatically detect modems, we
advise against using this option as auto-detect may cause
some multiprocessor systems to lock up.
The list of modem manufacturers and models displays.
6. Select the appropriate manufacturer and model and click OK.
If the correct manufacturer and model do not appear on the list,
click Have Disk to install software from a manufacturer-supplied
installation diskette.
A list of all available COM ports displays:
7. Select the port on which you wish to install the modem. If you
have multiple modems of the same type (for example, four
RocketModem cards), you can select more than one port and
install all the modems at the same time.
8. Click Next. The modem software is installed on the selected ports.
Depending on prior configuration, you may be asked to enter your
country of use, area code, the number you dial to get an outside
line, and whether you have tone or pulse dialing at this time.
9. Click Finish.
The Modems Properties dialog box displays:
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10. If you need to configure modem properties (maximum baud rate,
data bits, parity, and so on), click the Properties button, make the
needed changes, then click OK to return to this window.
11. If you need to configure dialing properties (country, area code,
calling card number, and so on), click the Dialing Properties button,
make the needed changes, then click OK to return to this window.
12. Click Close.
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Further Configuration
At this point:
•

If you are not using RAS, you are now finished. Reboot the server
so that your changes take effect and resume normal operations.

•

If you plan to use RAS but do not have it installed yet, reboot your
system, then go to Initial RAS Installation on page 50.

•

If you already have RAS installed and configured, this dialog box
displays:

If you do not want to configure this modem for use with RAS at this
time, click No, then reboot and resume normal operations.
If you do want to configure this modem for use with RAS, do not
reboot. Instead, click Yes, then go directly to Adding or
Reconfiguring a RAS Device on page 53

Configuring Modems

49

Windows NT

RAS Installation and Configuration
After installing the software, and installing and configuring at least
one RAS device (for example, a modem), use this section to install and
configure Remote Access Service (RAS).
Initial RAS Installation
If you have not previously installed RAS in your Windows NT server,
log into the server with Administrative rights and follow these steps:
Note: This example shows how to install and configure RAS for use
with modems, but you can use it as a guide to setting up other
serial devices.
1. Open the Control Panel and start the Network applet, or right-click
on the Network Neighborhood and select Properties. The following
screen displays:
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2. If Windows NT 4.0, select the Services tab.
If Windows NT 3.51, select the Add Software button, highlight the
Remote Access Service selection, and click the OK button. The
following screen displays:

3. Click the Add button. The Select Network Service screen displays:
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4. Highlight Remote Access Service and click the OK button. You are
asked to specify the location of the installation files.
5. Enter the location of the Window NT files (for example, d:\i386)
and press the Continue button.

The appropriate files are copied onto your hard drive.

The RAS installation process automatically launches the Add RAS
Device process. Go to Adding or Reconfiguring a RAS Device, Step
5.
Note: If you install or reinstall RAS from your original Windows NT
4.0 distribution media, you must install or reinstall Windows
NT Service Pack 3 after installing/reinstalling RAS. This is
necessary because Service Pack 3 includes RAS-related files that
are newer than the files on the NT distribution media.
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Adding or Reconfiguring a RAS Device
There are several different ways to start this procedure:
•

•

•

If you have previously installed RAS and configured at least one
RAS device, and are now adding or reconfiguring RAS devices,
begin with Step 1.
If you have previously installed RAS and were in the process of
installing a modem when this process started automatically, begin
with Step 4.
If you were in the process of installing RAS when this process
started automatically, begin with Step 5.

Follow these steps:
1. Open the Control Panel and start the Network applet, or right-click
on the Network Neighborhood and select Properties. The Network
window displays.
2. If Windows NT 4.0, select the Services tab.
If Windows NT 3.51, highlight the Remote Access Service selection
and click OK.
3. Highlight Remote Access Service and click the Properties button.
4. The Remote Access Setup window displays:

To reconfigure an existing RAS port, highlight the port/device and
click the Configure button. Then go to Step 8.
To add a new RAS device—for example, if you are configuring a
new modem—click the Add button.
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5. The Add RAS Device window displays:

6. Use the droplist to select the COM port (modem) that you want to
configure and click the OK button.
The Remote Access Setup window displays again:
7. Highlight the desired COM port (Modem) and click the Configure
button.
8. The Configure Port Usage window displays:
9. Select the appropriate radio button, based on the role the modem
will perform, and click the OK button.
Note: When configuring multiple simultaneous RAS dial-in ports,
configure the ports to “Receive calls only” not “Dial out and
Receive.” Configuring a port to dial-out requires a separate
memory pool for each dial-out port, while all ports
configured for receive-only share the same memory pool.
If you configure too many ports for dial-out unnecessarily,
resources can become an issue. If you require dial-out on the
RAS server, configure one port to “Dial out and Receive”
and all the other ports to “Receive calls only.”
The Remote Access Setup window displays again.
10. Highlight the COM port (modem) again and click the Network
button.
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The Network Configuration window displays:

11. Select the appropriate dial out protocols, dial in protocols, logon
security levels, enable multilink (if required) and click OK.
Note: Only previously configured protocols are selectable. If you
want to set up a protocol that is grayed out, you must first
add it using the Network Protocols tab.
If you selected “Receive calls only” on all ports while configuring
the port usage, the “Dial out Protocols” area will be shaded.
Windows NT 4.0: If you want to use Multilink PPP (bonding), make
sure that you click the Enable Multilink checkbox.
For detailed information about the configuration screens, use the
Help button or the Windows NT CD-ROM (Support/books/
server.hlp file to locate information).
The following steps are dependent upon the protocol selections
made in this screen.
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12. If you select NetBEUI on the Network Configuration screen, the
following window displays. Make the appropriate selection for
your environment and click OK.

13. If you select TCP/IP, the following window displays. Make the
appropriate selections for your environment and press OK.
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14. If you select IPX, the following window displays. Make the
appropriate selection for your environment and press OK.

15. Click OK to exit the Network Configuration screen and return to
the Remote Access Setup screen.
16. If you want to duplicate the configuration you just created on any
other COM port (modem), highlight the COM port number and
click Clone. Otherwise, repeat Steps 8 through 15 for each COM
port (modem) you want to set up.
17. After setting up all the COM ports, click the Continue button.
18. Click the Close button at the Network/Services tab to complete the
RAS installation.
19. Click Yes when asked to reboot the computer.
Windows NT RAS installation is complete.
20. If necessary, install the latest NT Service Pack or Packs from
Microsoft.
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Printer Configuration
Use this section to connect a serial printer.
Adding Serial Printers
Follow these steps to configure a serial printer in Windows NT:
1. Connect the printer to the desired port. Use a DTE-to-DTE null
modem cable unless the printer maker specifies otherwise.
2. Open the Printers control panel and double-click on the Add
Printer icon. The Add Printer Wizard starts.

3. Click the My Computer checkbox, then the Next button.
Note: This differs from Windows NT 3.51. Under NT 3.51,
printers on Comtrol ports are network devices.

58

Printer Configuration

Windows NT

A list of available printer ports is displayed.

4. If the desired COM port is on this screen, select it, click on the
Next button, and skip to step 6.
5. If the desired COM port is not on this list, click the Add Port
button and follow these steps:
a. A list of printer ports is displayed. Click Local Port.
b. Click New Port.
c. Type in the name of the port.
Note: Port names above COM9 require the \\.\ prefix. For
example, to reference COM12, enter \\.\COM12.
d. Click the OK button.
e.
f.

Click the Close button to return to the Add Printer Wizard.
Click the Next button.
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A list of printer manufacturers and model is displayed.

6. Select the printer make and model and click the Next button.
If your printer is not on the make and model lists, but you have a
manufacturer-supplied printer diskette, click the Have Disk button.
If you have already installed another printer using this driver, you
are asked if you want to keep the existing driver.
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7. To keep the driver, check Keep existing driver and click Next to skip
to step 8.
If you choose Replace existing driver, or if you have not previously
installed this driver, you are prompted to insert either the
Windows NT CD-ROM or the manufacturer’s printer diskette. Do
so and click Next.
8. Select whether you want this printer to be the Windows NT
default printer, and click on the Next button.

9. Select whether or not you want to share this printer with other
computers on the network. If you select Shared, you are asked to
indicate the operating systems of all the computers that will be
sharing this printer. (You may also be required to insert the
operating system media so that Windows NT can extract the
necessary driver files.)
10. Select whether to print a test page and click on the Finish button.
You are now ready to begin using the printer. No reboot is needed.
Changing Printer Port Configuration
If the printer does not successfully print the test page, it may be
necessary to change the port baud rate, parity, and so on. If the Ports
applet does not configure the port properly, you may have to use the
mode command from a DOS prompt. Also, check the printer for DIP
switches or other hardware configuration options.

Printer Configuration

61

Windows NT

Changing Printer Port Assignment
To change the port assigned to a printer, follow these steps:
1. Open the Printers control panel.
2. Right-click on the icon for the printer you want to change.
3. Select the Properties option from the menu. The Properties window
is displayed.
4. Click the Ports tab.
Note: The Properties window also gives you access to printer test
and setup options that can be very helpful when debugging
a serial printer installation.
5. Check the port you want to switch to. Remember to change your
cabling accordingly.
Note: The Configure button on the Ports tab does not recognize
Comtrol ports. This is a limitation of Windows NT. If you
need to reconfigure the port, use the Ports option on the
Control Panel.
6. Click on the OK button. Any changes you make take effect
immediately. No reboot is needed.
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Using Test Terminal (wcom32.exe)
WCOM32 is a terminal program that enables you to open a port, send
characters and commands to the port, and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access
Service is running or any other application is using the port. If
you are using RAS, you must stop the service before starting
WCOM32 to test RAS COM ports. To test ports that are not used
by RAS, you do not need to stop RAS.
To start WCOM32, select Test Terminal from the Comtrol program
group. The program window displays:

Follow these steps:
1. Select Open Port from the Port menu. A list of possible COM port
numbers displays.
2. Select the COM port you want to test.
If the COM port does not exist or if it is currently being used by
another program, a Create File Error message displays.
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If the COM port is available, a terminal window pops up:

Note the <loop> button in the terminal window. If this option is
activated, it is green and uppercase (
), the COM port internal
loopback feature is activated and the data is returned by the COM
port hardware. If this option is deactivated, it is gray and lowercase
(
), the internal loopback is deactivated, and the data is being
sent out the COM port.
Testing a RocketPort Serial Hub
1. Place a loopback plug on the COM port you are testing. Make sure
all connectors are seated firmly and that the loop button is off.
2. From the Port menu, select Send Test Data. The program sends out
a repeating data stream. To stop this, select Send Test Data again.
If the loopback plug is in place and the port is working correctly, the
test data should be echoed back to the screen.
If the loopback plug is not in place or the port is not working
correctly, no data or garbled data is echoed back to the screen.
Note: If no characters appear, try putting the loopback plug on an
adjacent port. It may be that you have the ports mixed up.
3. If further testing is required, select Loopback Test from the Port
menu. If the loopback plug is in place and the port is working
correctly, the system should return the message “Passed.”
If the loopback plug is not in place or the port is not working
correctly, the system will return the message “Failed.”
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4. If the port has failed in Step 2 or 3, and the RocketPort Serial Hub
is equipped with an external interface box or fanout cable, click
the loop button to switch the internal loopback feature on.
5. Repeat Steps 2 and 3. If the port now passes the tests, the fault
may lie in the interface box or fanout cable. Contact Comtrol
technical support for more assistance.
Modem Control Signals
The terminal window displays the modem control signals as gray or
green lights at the top of the window. The first four are inputs:
The lights are green if they are turned on, or gray if off. The text on the
light also changes from uppercase (CTS), which is on, to lowercase (cts),
which is off.
The next two lights are outputs:
RocketPort Serial Hub: if you have a loopback plug connected and you
click on one of the outputs, the corresponding signal is sent to the input
and the input lights should toggle accordingly.
The rightmost light is the loop indicator:
If this is on, the COM port internal loopback feature is activated and
any information or code entered in the terminal window loops back
through the COM port circuitry. If this is off, the COM port internal
loopback is deactivated, and any information or code entered in the
terminal window is sent out of the port.

Using Port Monitor (portmon.exe)
The Port Monitor program (portmon.exe) offers a summary of all
RocketPort Serial Hub statistics in one easy-to-read spreadsheet view.
It also enables you to verify operation of all RocketPort Serial Hub
ports from a single window.
The Port Monitor display follows the familiar spreadsheet model: each
COM port is a horizontal row, and each vertical column displays a
variable or value for the respective COM port. (For definitions of the
abbreviations used, see Table 3 on page 71.)
Port Monitor can also produce statistics and reports that can help you
verify the operation of the COM ports and connected peripherals.
Some immediate feedback includes:
•
•

The state of the modem control and status signals
Open ports
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•
•

Raw byte input and output counts obtained from the driver
Port errors

The available statistics include:
• Instantaneous characters per second (CPS) calculations
•

Minute, hour, and day CPS averages and peaks

• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily
basis, and can cover all ports collectively or a separate report for each
port. You can also set how often the values are recalculated, fine-tuning
thoroughness against system efficiency, and automatically run
external batch files to perform additional processing and analysis.
Starting Port Monitor
To run Port Monitor, select Monitor from the Comtrol program group.
The monitor window displays:
Once the monitor window displays, Port Monitor is active and
collecting data. If any cumulative data has been saved from previous
sessions, it is automatically brought in and used.
Port Monitor continues to run and collect data until you terminate it,
at which point all accumulated data is automatically saved for use in
the next session.
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Changing Screen Appearance
While Port Monitor is running, there are a number of commands and
controls that change the appearance of the screen.
Table 2. Port Monitor Screen Commands
Desired Change

Procedure

Change the monitor window font. Select Font from the Edit menu.
Left-click on the column separator
Change width of a single column. (vertical) line and drag it to the
desired width.
Change column placement.

Left-click in the middle of the
column you want to move and
drag it to the desired location.

Remove a column.

Right-click on the column you
want to remove and select Remove
from the pop-up menu.

Right-click on the upper left cell
Clear all fields and reset them to
in the table and select Reset from
null values.
the pop-up menu.*
Clear any single field except the
upper left cell.

Right-click on the field to be
cleared and select Reset from the
pop-up menu.*

Add a column.

Right-click on the column now
occupying the desired location
and select Add from the pop-up
menu.
You are prompted to name the
variable you want to display, as
well as other information. (See
Column Setup, below.)
After you click OK, the column is
inserted in the selected location
and the existing column is moved
to the right.

Change other properties of a
column.

Right-click on the column and
select Properties from the pop-up
menu. (See Column Setup, below.)

*

The Reset command does not clear raw data from the calcs.dat file.
It simply resets the selected display fields to their null values. For
more information regarding calcs.dat see page 70.
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Column Setup
When you select Add or Properties from the column pop-up menu, the
Column Setup window displays:

Use the Input droplist to select the variable displayed in the column.
Use the Type droplist to select the way in which the value displays:
either as an integer, as an on/off state, as an integer with a kilo, mega,
or giga suffix, or as an hh:mm:ss time stamp. This defaults to the
appropriate type for the selected Input variable.
Use the Name variable to change the column heading name.
Use the Width variable to specify the column width in characters.
Use Color0 to set the column character color when the value is zero.
Use Color1 to set the column character color when the value is not zero.
When done, click OK to save your changes and return to Port Monitor.
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Report Configuration
To configure reports, select Config from the Edit menu. The Program
Setup window displays:

The Single report options cover all ports and are overwritten each time
the reports are generated. The Multiple report options generate a
separate report for each port, and each report file is appended each
time the report is generated.
For Hour reports, use the Single and Multiple droplists to select
whether you are generating single or multiple reports, or both. For
each report type, select from the following types of data to include:
• None: no report is generated.
•

Hour Data: only variables with “Hour” in the name are included.

•
•

All Data: all variables are included.
View Data: only variables that appear on-screen are included.

The External Program field is used to enter a command line to run
another program after the hourly reports have been generated. For
example, you can use this to run a batch file that performs custom
report processing. The Test button causes the command line to be
executed immediately.
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For Day reports, the single and multiple droplists behave the same, but
your choices are:
•
•
•
•

None: no report is generated.
Day Data: only variables with the words “Day” or “Raw” in the
names are included.
All Data: all variables are included.
View Data: only the variables that appear in the Port Monitor
window are included.

Likewise, the External Program field is used to enter a command line to
be executed after the daily reports have been generated.
The Update Time option allows you to set the rate at which the port
information is obtained and the calculations performed. There is a
trade-off between Port Monitor efficiency and response time. If you are
using Port Monitor to view the port activity on the screen, you may
want to set the update time to 1 or 2 seconds, so that the screen is
updated frequently. If you are concerned about the monitor program
using CPU resources, set this to a higher value, (6 to 20 seconds) in
order to decrease the time required by the program to perform the
calculations and update the screen.
If Port Monitor is left active to generate reports, minimizing or
reducing the display area of the program will help reduce CPU
requirements of updating the screen.
Port Monitor Files
Port Monitor creates and uses the following files:
•

portmon.vew

• calcs.dat
The default column layout is saved in portmon.vew. If you have been
experimenting with the appearance of the monitor screen, you can use
the File menu Save option to save your customized layout in
another.vew file. You can retrieve this file later by using the File menu
Open option, or you can use the Edit menu View Default option to
retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour
in a binary file named calcs.dat. This enables you to halt Port Monitor
execution without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily
reports are saved in this directory, under the following names:
• hall.txt — hourly single report
•
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•

hcomx.txt — hourly multiple reports, where x is the port number

•

dcomx.txt — daily multiple reports, where x is the port number

Caution: Since multiple reports append new data each time they are
written, the multiple report files grow in size. It is up to you to
delete them periodically.
Some safeguards are built into the program to avoid filling up a hard
disk drive due to growing report files. The monitoring program stops
writing additional data to the multiple reports if they reach a size of 2
MB. Also, the program will not write out data files to the disk drive if
the spare room on the drive is less than 2 MB in size.
To view or edit an hourly or daily report, use the Edit Report option on
the File menu, or use a system tool such as NOTEPAD.
For more information, see the Port Monitor Help file.
Port Monitor Variables
The following table lists Port Monitor variables.
Table 3. Port Monitor Variable List
Variable

Description

Open

Open status, on if open, off if closed.

Cts

Input CTS pin status.

Dsr

Input DSR pin status.

Cd

Input CD (carrier detect) pin status.

Rts

Output RTS pin status.

Dtr

Output DTR pin status.

TxTotal

Total bytes transmitted.

RxTotal

Total bytes received.

TxCPSInst

Instantaneous average of transmit
characters per second.

RxCPSInst

Instantaneous average of receive characters
per second.

Errors

Total hardware receive errors (parity,
framing, and overruns.)

TxMinCPS

Last minute average of transmit characters
per second.

RxMinCPS

Last minute average of receive characters
per second.
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Table 3. Port Monitor Variable List (Continued)
Variable

Description

TxCPSMinAvMax

Peak TxCPSInst for the last minute.

RxCPSMinAvMax

Peak RxCPSInst for the last minute.

TxCPSHourAvMax

Peak TxMinCPS for the last hour.

RxCPSHourAvMax

Peak RxMinCPS for the last hour.

TxCPSDayAvMax

Peak TxMinCPS for the last day.

RxCPSDayAvMax

Peak RxMinCPS for the last day.

TxTotalRaw

Total number of transmit bytes raw data
from the driver.

RxTotalRaw

Total number of receive bytes raw data from
the driver.

TxMinCnt

Count of transmit bytes sent in last minute.

TxHourCnt

Transmit bytes count sent in the last hour.

TxDayCnt

Transmit bytes count sent in the last day.

RxMinCnt

Receive bytes count sent in the last minute.

RxHourCnt

Receive bytes count sent in the last hour.

RxDayCnt

Receive bytes count sent in the last day.

TxMinCntWrk

Transmit bytes count sent in this minute.

TxHourCntWrk

Transmit bytes count sent in this hour.

TxDayCntWrk

Transmit bytes count sent in this day.

RxMinCntWrk

Receive bytes count sent in this minute.

RxHourCntWrk

Receive bytes count sent in this hour.

RxDayCntWrk

Receive bytes count sent in this day.

TxCPSMinAvMaxWrk

Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.
TxCPSDayAvMaxWrk

Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.
RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.
RxCPSDayAvMaxWrk

Peak RxHourCPS for the current day.

CDRuns

Carrier detect turn-on count.
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Table 3. Port Monitor Variable List (Continued)
Variable

Description

CDDayRuns

Carrier detect turn-on count in the last day.

CDDayRunsWrk

Carrier detect turn-on count in the current
day.

CDRunTime

Time in seconds carrier detect has been on.

CDHourRunTime

Time in seconds carrier detect has been on
in the last hour.

CDDayRunTime

Time in seconds carrier detect has been on
in the last day.

CDHourRunTimeWrk

Time in seconds carrier detect has been on
this hour.

CDDayRunTimeWrk

Time in seconds carrier detect has been on
this day.

StatusFlags

Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts

Raw count of total transmit packets sent.

RxPkts

Raw count of total receive packets sent.

OverrunErrors

Total count of receive overrun errors.

FramingErrors

Total count of receive framing errors.

ParityErrors

Total count of receive parity errors.

OverrunErrorsRaw

Total count of receive overrun errors, from
the driver.

FramingErrorsRaw

Total count of receive framing errors, from
the driver.

ParityErrorsRaw

Total count of receive parity errors, from the
driver.
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Using Peer Tracer (peer.exe)
The Peer Tracer program (peer.exe) is specifically designed to view the
internal operations of the driver, for the purpose of troubleshooting
communications systems. Peer enables you to see:
•
•

Receive and transmit data
Internal driver event traces

• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used
to send and receive text information to and from the driver. To use
Peer, you type in commands, and status and information are sent back.
Unlike Test Terminal, Peer enables you to keep a continuous log of the
commands sent and the results received, in a file named peer.log.
Comtrol Technical Support may ask you to run Peer in order to help
diagnose reported problems.
Starting Peer
Peer Tracer does not appear in the Comtrol program group. To use it,
you must open Windows Explorer, access the C:\WINNT\system32\
directory, and double-click on peer.exe. The Peer Tracer window
displays:

Log Functions
All logging functions are found under the File menu. To start keeping
a log, select Log to Disk from the File menu. The other options on this
menu are View Disk Log, Clear Disk Log, Clear Screen, and Exit.
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Using Peer
To use peer, simply type in commands at the : prompt. (It may be
necessary to press Enter to make the : prompt appear.) For example, to
examine COM5, type:
PORT COM5 <Enter>
To gather some information about the port, type:
STAT <Enter>
This should return details about the port.
To turn on monitoring of any calls into driver (events), type:
MON EV <Enter>
To send strings and commands to attached peripherals—for example,
to send “ATH0” to a modem—type:
SEND ATH0 <Enter>
A return and linefeed are always appended to each string sent.
Other Commands
Enter commands at the : prompt and follow each command with Enter.
Table 4. Peer Tracer Commands
Command

Effect

MON TX

Monitor data being transmitted
through the selected port.

MON RX

Monitor data being received
through the selected port.

M

Turn off all monitoring.

?

Display Peer Tracer command
summary.

PORT COMxx

Change port being examined to
COMxx.

Keep in mind that all commands are processed in the driver, and that
Peer simply acts as a conduit for this information.
For more information, see the Peer.hlp help file.
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Using the Device Advisor
You can use the Device Advisor to determine the following
information:
• Summary of the device status
•
•

The MAC address of the network interface card (NIC)
The NT bind string (GUID)

•

The RocketPort Serial Hub MAC address

•
•

Detailed state of the RocketPort Serial Hub
Total number of successful load attempts

•
•

Total number of RocketPort Serial Hub units on the network
Transmit statistics, such as the number of:

•

-

Frames out

-

Packets to device
Retransmitted frames

Receive statistics, such as the number of:
-

Frames accepted
Frames passed on

-

Packets from device
Out of sequence frames

Note: For detailed information about the fields in the Device Advisor,
use the online help available in the application.
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Use the following procedure to access the Device Advisor:
1. Start the VS-Link menus using one of the following methods:
•

Use the Start button, as displayed below:

2. Highlight the device that you want to review.

3. Click the Properties button.

Using the Device Advisor
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The Device Properties sheet appears:
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4. Click on the Device Advisor tab.

Note: For detailed information about the fields in the Device Advisor,
use the online help available in the application.

VS-Link Messages
The following tables provide information about VS-Link summary
messages and reported state messages.
Table 5. VS-Link Summary Messages
Message
Uninitialized

Description
VS-Link has not been installed correctly.

Unable to contact
VS-Link NT driver

The VS-Link NT driver is not installed or is
not responding to Device Advisor requests.

Unable to contact
a Network Interface
Controller (NIC)

The server NIC card may not be installed,
may be malfunctioning, or may not be bound
to VS-Link.

VS-Link Messages
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Table 5. VS-Link Summary Messages (Continued)
Message

Description

No inbound traffic of any sort is detected.
Cannot detect network The VS-Link device may be inoperative or
you may have a network cabling problem.
Cannot detect any
VS-Link units.

Network traffic is being received, but not
from a VS-Link device. Check the network
connections and verify that the VS-Link
device is powered up.

Network traffic is being received from a
VS-Link device, but not the one specified in
Cannot detect VS-Link Device Setup. Check the device to make sure
unit with specified
that you are using the correct MAC address
MAC address.
in Device Setup, and check the Main Setup
window to verify that you are working with
the correct device.
VS-Link device with
specified MAC address
was detected, but is not
configured for this
server.

Either the VS-Link device in question is not
assigned to this server, or (either in primary
or backup mode), it is not assigned to any
server, or it has been configured for this
server but the configuration has not been
saved. If the latter, return to the Device
Setup window, save and exit, and restart the
server

VS-Link device
detected and
configured for this
server, but is not yet
assigned to this server.

Either the VS-Link device is currently being
controlled by another server (for example, a
backup server), or the device power has been
cycled and the device is waiting for a server
to acquire it.

VS-Link detected,
initializing.

The server has acquired the VS-Link device
and is downloading the control program. The
device will be available shortly.

VS-Link responsive,
but no data traffic
exchange since last
inquiry.

The VS-Link device appears to be installed
correctly and active, but no data traffic has
been sent or received since the last time you
clicked the Refresh button. If there should
have been traffic, check the VS-Link port
configuration and external cabling.

VS-Link responsive;
data traffic received, Similar to above, except the VS-Link device
but nothing sent since has received data successfully.
last inquiry.
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Table 5. VS-Link Summary Messages (Continued)
Message

Description

VS-Link responsive;
data traffic sent, but Similar to above, except the VS-Link device
nothing received since has sent data successfully.
last inquiry.
VS-Link active.

Normal state: the VS-Link device is installed
correctly and active with data traffic.

Poor connection to
VS-Link.

This message displays if retransmissions are
occur, frames arrive out of sequence, or more
than 2% of the total packets arrive out of
sequence. This generally indicates a cable,
connector, or LAN termination problem.

Counts reset.

This message displays immediately after you
click the Reset button.

Table 6. VS-Link Reported State Messages
Message

Description

Invalid

An illegal VS-Link state has been detected.
Reset the VS-Link device.

Init

This is the normal state for undetected and
inactive VS-Link devices.

InitOwn

The server has acquired the VS-Link device
but has not downloaded the control software.

SendCode

The server has acquired the VS-Link device
and is in the process of downloading the
control software.

Connect

The server has completed the download and
is completing initialization.

Active

The normal state for a VS-Link device that is
attached to an NT server and is ready for
data traffic.

Not found

The specified MAC address is not configured
on this NT server.

Undefined

No VS-Link devices are configured on this
NT server.
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